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1 Overview

This document provides a detailed description on the usage constraints of minimalist networks and the solutions to problems
that frequently occur during network deployment, in order to guide the after-sales personnel to deploy and implement minimalist

network solutions, thus improving deployment efficiency and quality.

Audience

® Network Engineers

® Network Administrator

Obtain Technical
Assistance

®  Ruijie Networks Websites : http://www.ruijienetworks.com

®  Ruijie Service Portal : http://case.ruijienetworks.com

Welcome to report error and give advice in any Ruijie manual to Ruijie Service Portal

Related Documents

® RG-Application Software FAQs V1.1

Revision History

Date Change contents Reviser
2016.09.01 Initial Release Amy & crystal
2017.02.01 Add new chapter of 4.1 SMP | TAC Oversea

Q12-Q22, 4.2 SNC Q11, 4.3
SAM on Publication V1.1
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2 Introduction to the Index

This document collects the frequently asked questions (FAQs) about minimalist networks and provides answers by category.
Because the questions are not indexed, to search for a specific question, press the shortcut key Ctrl+F in the document and

enter keywords of your question in the search box.
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4 FAQ

4.1 SMP

Q1: Database backup and restore

The database backed up on the Security Management Platform (SMP) can be restored to the SMP of the same version. For

example, you can restore the database that is backed up on 2.63_EN_Build20151106 only to 2.63_EN_Build20151106.
Q2: Does it matter if alog4j error is displayed?

As shown in the following figure, the error marked in the red box does not affect the normal operation of the SMP. Such
information is displayed during the startup of Tomcat.

@\_ RG-SMP Security Management Platform Professional - X
Service Manager Service Settings DataBase Settings Maintain License Option L7
ale
=%
art Slop Restart Install Uninstall
Semvice Control Service Operator
SHF/ jbozs/zerver/default/deploy/ jboss—xa—jdbe. rar/META-INF/ra. znl =

13:37:11, 876 INFO [RéARDeployment] Required license terms exist, wview wiszip:/D:/RG-
SMF/ jboss/ zerver/default/ deploy/ ins-ra. rar/MET4-INF/ ra. xml
13:37:12, 124 INFO  [ConnectionFactoryBindingService] Bound ConnectionManager
" jboss. jea: service=DataSourcebinding, name=3KFPDE to JHDI name * java: SMPDE®
13:37:12, 161 INFO [TomcatDeployment] deploy, ctxPaths/=mp
$af:la, ogd]: ruljielogger out Tile has hcen_cmged to U!\mnhoss Server
Sdefaultiloghump. log
13:37:17,111 ERROR [STDERER] logdj:WARN Continuazble parsing error 32 and column 23
13:37: 17,111 ERROR [STDEER] logdj:WAEN The content of element type "logdj:configuration” must match
“(renderer#, appenders, {category|logzer)#, root?, categoryFactory?) ",
13:37:17, 210 ERROR [STDERR] logdi:WARN Mo appenders could be found for logzger
{com. ruijie. core. logging. strategy. DefaultloggerStrategy).
13:37: 17,210 ERROE [STDERR] logdj WAFN Pleasze initialize the lngd_] sys'ten properly.

EEdy It UZe ITof I, 210 Rours.

13: 3'? 49 4‘-14 INFO [STDOUT] Client i{c\n:tollnz Scrvlce star‘ted (llstenlnz port:63)!

13:37:49, 469 INFO  [STDOUT] The system (2016-08-23 13:37:48) started succezsfully. The IF address is

(172, 29.2.4). |
13:137:82, 183 INFO [HttpllProtocol] Starting Coyote HITP/L.1 on http—1T2. 28, 2, 4-8080 [
13:37: 82, 220 INFO [HttpllProtocol]l Starting Coyote HITP/1.1 on http-172. 28, 2. 4-80 -

|, Installation Path:D:\RG-SMP\ .z

Q3: Can the SMP be connected to a third-party NAS for web authentication?

The third-party NAS device should support the China Mobile Portal 2.0 protocol. For example on a H3C switch, if the following

command can be run, it can be used to connect with an SMP.

portal url-param include user—-mac param—name wlanuseprmac

portal url-param include nas—ip param—name wlanacip

portal url-param include user-url param—name url
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[H3C Iportal sewrver smp ip 18.1.1.185 server—type

cmcc  Server type is cmcc

imc server type 15 1imc

The supported H3C switches include H3C WX3024, H3C WX5004, and H3C WX5510.

Q4: Can SMP support integrate with multiple third-party identity centers or AD domains?

For example, if both the Lightweight Directory Access Protocol (LDAP) protocol and active directory (AD) domain exist, the

SMP support integrate with only one of them. However, the SMP support integrate with multiple AD domain servers.

Q5: When adding users to the SMP, the system indicates that the license is insufficient, and the SMP service manager

indicates that at most 0 online user is allowed.

This message is displayed when the Micro Dongle is not correctly used. The Micro Dongle of the SMP and SNC is the same
in look and may probably be misused. If the SNC Micro Dongle is used by fault, the SMP Micro Dongle can also be started,

but the license displayed is incorrect.

@ RG-SMP Security Management Platform Professional Cod =02,
) Service Manager Service Settings DataBase Settings Maintain License Option fﬁé
b (=] 5y (2] (@
Start 5top  Restart Install Uninstall
Service Control Service Operator

11:06: 15, 158 INFO [RARDeployment] Required license terms exist, wiew vfszip:/D:/RG-

SHP/ jboss/server/default/deploy/ ins-ra. rar/META-INF/ra. xml

11:06: 15, 298 INFO [CornectionFactoryBindingService] Bound CornmectionManager

" jboss. jca:service=DataSourceBinding, name=SMPDE" to JKDI name ' java:SMPDB"

11:06: 16,471 INFO [TomcatDeployment] deploy, ctxPath=/smp

11:06: 16, 916 ERROR [STDERR] log4j:WARN ruijieLogger out file has been changed to D:\RG-SMP\jboss\server
\default\loghump. log

11:06:20,409 ERROR [STDERR] logdj:WARN Contirmable parsing error 32 and column 23

11:06:20,408 ERROR [STDERR] logdj:WARN The content of element type "logdj:configuration” must match
“{renderer*, appender*, (category|logzer)*, root?, categoryFactory?)”.

11:06:20, 596 ERROR [STDERR] logd4j:WARN No appenders could be found for loggzer
(con ruijie. core. loggxng strategy DefaultLoggerStrategy)

11:06:54, 914 IHFO [STDOUT] The off:.c:.al wersion allovs up to 0 online accounts {including userz and MAC
address authent:.cat:.on devices). 1 accounts are online currently. Please remove spare accounts before

11: 06 55,438 INFO [STDOUT] The rumber of online users has exceeded the upper limit specified by the
licensze. The system automatically exaits.
11:06:56,462 ERROR [STDERR] BIUSZAFISUEHR !

Q6: What should I do if | forgot the password of the SMP admin?
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In SMP2.63 and later versions, find the data table “T_ADMIN” in the database “SMPDB”, and change the field of admin
password to “316901EEFC21AE17FEQ7B76BF922CF5C”, and the password is resetto “111111111”. You can also run Update
T_ADMIN SET password='316901EEFC21AE17FEQ07B76BF922CF5C' where adminID="admin’' to reset the password.

Q7: How to calculate the number of SMP authenticated user?

SMP 2.63 authentication calculates the number of online users. It has nothing to do with the total number of created users, the
number of allowed login times, and the type of the used client. For example, if you purchase 50 licenses, 50 concurrent online

users are allowed.

Q8: How to synchronize the passwords if the SMP is integrated with AD domain Server?

On SMP 2.65 and earlier versions, the function "Learn new user’s password during authentication" is enabled by default.

Each time when an AD domain user is authenticated, the user password is checked in the AD domain. The password will be
saved locally if the password check is successful. When the communications between the SMP and the AD domain is faulty,

the user password that is saved locally can be used for user authentication.

If the local password of the SMP is changed, the password in the AD domain is not affected. Upon user authentication, the
password will be checked in the AD domain and saved to the SMP locally. If the password in the AD domain is changed, the
new password is checked in the AD domain when it is used for authentication, and synchronized to the SMP. Given that
Windows AD domain has a mechanism that can delay the expiration of the previous password, the previous password can still

be used in a period of time after the AD domain password is changed.

Q9: How does an SMP perform authentication when SMP is integrated with multiple AD domains?

Use the format domain name\user name or user name@domain name to perform authentication in the designated domain.

Q10: What are the keep-alive configurations for SMP user in Web authentication?

Wired Web authentication user: It is recommended to enable the online status detection function for a wired Web authentication

user (If the keep-alive page of successful authentication is turned off, the user is forced offline in three heartbeat periods).

Choose Authentication & Authority > Portal Settings > Heartbeat Detection on Web-authenticated Users

Heartbeat Detection on Web-authenticated Users
* Detection Interval: 5 minutes (Default: 5)

Wireless Web authentication user: Enable traffic keep-alive on the AC as recommended.

4-6
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WS6108(config)#offline-detect interval 10 threshold 100

If the wireless data traffic is smaller than 100 bytes in 10 minutes, the wireless user is considered as offline.

Q11: Why Are 802.1x Authenticated Users Disconnected from the Network Immediately After They Go Online?

Fault symptom: A wireless 802.1x authentication device is associated with the Security Management Platform (SMP). After a

user goes online on the SMP successfully, the user is disconnected from the network immediately. The prompts displayed on

the AP show that the user goes offline actively because the four-way handshake fails.

Possible causes: Check authentication information on the SMP. No exception is found. Captured packets indicate that the
authentication type configured on the AC is inconsistent with that on the SMP. The root cause is that wired 802.1x authentication

is selected on the SMP.

Q12: The SMP Service of Version 2.63En Fails to Be Started Normally

Customer: UITM in Malaysia

Symptom: The logs as shown in the following figure show that the SMP service has been started.

14:55:38,437 INFO
14:55:38,484 INFO
address is (108.34

14:
14:
14:
14:
14:
14:
14:

55:
55:
55:
55:
55:

55
55

32,590
32,621
32,621
32,637
32,652

:32,668
:32,668

SWNTag=JBoss

INFO
INFO
INFO
INFO
INFO
INFO
INFO

[STDOUT] Client Monitoring Service started (listening port:53)!

[STDOUT] The system (2816-81-14 14:55:38) started successfully. The IP

.1.20).
[Httpl1Protocol] Starting
[HttpllProtocol] Starting
[HttpllProtocol] Starting
[HttpllProtocol] Starting
[Httpl1Protocol] Starting
[HttpllProtocol] Starting

Coyote
Coyote
Coyote
Coyote
Coyote
Coyote

HTTP/1.
HTTP/1.
HTTP/1.
HTTP/1.
HTTP/1.
HTTP/1.

]

on
on
on
on
on
on

http-10.
http-18.
http-10.
http-10.
http-10.
http-10.
[ServerImpl] JBoss (Microcontainer) [5.1.8.GA (build:

5 1 8 GA date=2080985221853)] Started in 1m:34s:614ms

Users fail to log in to the Web Ul of the SMP and the user authentication fails.

Cause: About 2000 UITM users apply for authentication. The SMP service may fail to be started normally if there are a large

number of authentication packets before start-up of the SMP service.

Perform the following operations to rectify the fault:

1.

Access the installation directory of the SMP, collect the log folder and the run.log file, and submit them to the Technical

Assistance Center (TAC).

Stop the SMP service.

34.
34.
34,
34.
34.
34,

T Y

. 28-86880
.28-88
.28-443
.28-28888
. 28-96898
.28-8443

Enable the firewall that comes with Windows, edit rules, and block TCP port 80 (user authentication port).

a)

Enable the firewall.

4-7



RG-Application Software FAQs V1.1

-

Public network settings

Q (® Turn on Windows Firewall

[ Block all incoming connections, including those in the list of allowed applications

Maotify me when Windows Firewall blocks a new app
a (O Turn off Windows Firewall (not recommended)

b)  Click Advanced Settings. In the Actions dialog box, select New Rule from the Inbound Rules from the drop-down list

and edit a new rule for blocking TCP Port 80.

ﬂ Windows Firewall ‘ Actions
« = ~ 4 @ > Control Pane Inbound Rules -
[ New Rule..
Control Panel Home . .
57 Filter by Profile 3
Allow an app or feature SF Filter by State »
through Windows Firewall )
®) Change notification settings W Filter by Group >
) Turn Windows Firewall on or View 4
off
| Refresh
) Restore defaults
=, Export List...
W Ldvanced settings = P
Troubleshoot my network E Help

4.,  Start the SMP service.

5. Disable the firewall.

Q13: Hardware Information Fails to Be Collected After the SMP Service of Version 2.63 Is Deployed

Fault description: Hardware information fails to be collected after the SMP service is newly deployed, as shown in the following

figure.
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doayetoﬂllm

-vb \v

oo i, mmmwmms.mm
at org jboss Main boot(Main java 221)
at org jboss Main$1.run{Main java 556)
at java lang Thread run(Thread java.662)
17:17:10.878 WARN |

Solution: Install the patch (Release Notes for RG-SMP_2.63_EN_Build20151106 to rectify this fault. Ensure that all files are
replaced. Otherwise, a license error will occur. In addition, install relevant patches.

mmmmwmamwmuwﬂuw
Jroot? categoryFactory?)”
OR [STDERR] logdj WARN No appenders could be found for logger
 DefaultLoggerStrategy).

” % pmm'mwmmmmmqmm
mmmmaﬁamemwmm

Q14: What Will Happen After the Test Dongle of the SMP Is Inserted into the SNC?

The dongles of the Smart Network Commander (SNC) and SMP are completely the same in appearance and are both red.

4-9
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If the test dongle of the SMP is inserted into the SNC mistakenly, the SNC service can be started normally. However, when the
homepage of the SNC is opened, the homepage is stuck and a prompt, indicating that the SNC is not responding due to a

long-running script, is displayed, as shown in the following figure.

I_? Ui:[Té Smart Network Commander

10.10.240.1 is not responding due to a long ing script.

Q15: What Do | Do When a Fault Occurs After the SMP and AD Domain Controller Are Associated?

Fault Symptom

The SMP and Active Directory (AD) domain controller are associated. The authentication will fail when a user logs in by using

an AD account and the following prompt is displayed in the authentication logs of the SMP:

The password of the computer RG-SMP-SERVER s incorrect.

—ere e

‘Remote Windows AD

00 | sheenab | 293>%09 11010100253 A4SE6007972E |

Possible Causes

When the SMP and AD domain controller are associated, the PC account of the RG-SMP-SERVER needs to be added to the
AD server. Otherwise, the SMP fails to associate with the AD domain controller normally.

4-10
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Troubleshooting

Perform the following step to add the PC account of the RG-SMP-SERVER to the AD domain controller.

This step is a difficult step in deployment of the AD domain controller association because it involves the domain administrator
or domain management account. There are three methods of registering a PC name and changing the password. Select a
proper method based on the OS version of the deployed domain controller. Method 1 is applicable to Windows 2008 and later
versions, method 2 is applicable to Windows 2003 and later versions, and Method 1 or method 2 is recommended.

1. Apply to the domain
administrator for a common
Windows 2008 and | domain user account for SMP and
later versions (this | AD domain controller association,
| method is applicable | for example,
A domain . o
o only to  domain | smpadmin/ruijie_2014.
administrator )
controllers of | 2. Apply to the domain
creates a PC ) o
Windows 2008 and | administrator for a PC account,
account and )
Method 1 later versions. The | for example, RG-SMP-SERVER.
changes the PC ) ) | Recommended
3.23.1 ADSIEdit.msc tool is | 3. Instruct  the domain
password on the ) o
) unavailable on | administrator to change the
tool provided on _ _
~ | Windows 2003, and | registered PC password on the
the domain _ _
the PC password | ADSIEdit.msc tool provided on
controller. )
cannot be changed | the domain controller. Note that
even if the patch is | the changed password needs to
installed). be consistent with the password
of the association account
(smpadmin).
1. Apply to the domain
administrator for a common
) domain user account for
The domain o
o SMP and AD association,
administrator
for example,
creates a PC )
smpadmin/ruijie_2014.
account on the ) ]
Method 2 _ Windows 2003 and [ 2. Apply to the domain
domain ) o Recommended
3.2.3.2 later versions administrator for a PC
controller  and ] ) )
account. During registration,
asks a common ) )
when selecting the option
user to change ]
that the following users can
the password. )
add the PC to the domain,
add the preceding common
domain account smpadmin.

4-11
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3. On any PC added to the
domain (or add SMP to the
domain), use the approved
common domain  user
account to log in to the
device and run the .vbs
script for changing the PC
account password. The
entered password needs to
be consistent with the
password of the associated
account (smpadmin) during

script running.

1. Apply to the domain
administrator for a common
domain user account for
SMP and AD association, for
example,

. smpadmin/ruijie_2014.
The domain )
o 2. Apply to the domain
administrator o
administrator for a PC
creates a PC . )
account for registration on
account and )
Method 3 _ Windows 2003 and the account controller. Not
runs a script to ) ]
3.2.3.3 later versions 3. Instruct the domain | recommended
change the .
administrator to run the .vbs
password on the ) )
) script for changing the PC
domain
account password on the
controller. )
domain  controller.  The

password entered during
script running needs to be
consistent with the password
of the association account

(smpadmin).

Q16: How Do | Modify the Welcome Logo for Web Authentication?

Background: The SMP of the oversea edition allows users to customize the background picture, but not the welcome logo. If

the welcome logo needs to be modified, the relevant file needs to be modified on the SMP server.

4-12
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Aiwinistalr{anin] Login P [120.351 195 LoginDake 60627 0905.0)

ilonineUser A spen Saks  ChangePassword  ()lago
ericalon § Aty -
T Custom Login Page
System Wanknance
* Lagin Page Fiwe: 3L
ﬂBisi:Cnnlqunim L3 H |
P Beckgromd P oBe LognPage: I
[ Baigumnd Colwoilognfage: HEFTE |
0 Tos Thes MG The dinensions ofhelognpge plue mustos 552420 i ’ e
Ecm- ManagerPage
[ — E

The following figure shows the operation steps.
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~ Computer ~ Local Disk (D:) § RG-SMP v jboss ~ server ~ default ~ deploy ~ swp.war ~ porta ~ auth

B R ] common_user_auth_login - Notepad
Fle Edit Format View Help
i <input id="disclaimerEnable” name="disclaimerenable™ type="hidden" value="<c:out value: a|}~

p <input id="disclaimerTitle"” name="disclaimerTitle" type="hidden" value="<c:out value=':

<input id="disclaimerContent” name="disclaimercContent’ type="hidden” value="<cC:out vali
rods <input id="disclaimerLoginBtn” name="disclaimerLoginBtn™ type="hidden" value="<c:out vi
:Places

<input id="TloginactionName" name="loginactionName" type="hidden" value=". /webauthservl:

<¢:if test="${enableEsaauthen}">
<OBJECT ID="portalobject"” CLASSID="CLSID:5744FEFB-DC23-4D1A-ASCE-C8191CC5DD43"

ents <fciif>
g <div id="pageDiv" style="margin: auto; position: relative; ">
<div class="tip">
<div class="tipl">xxxxxx</div>
<div class="tip2">-\PMyyyy=</div>
r </div>
f’*(c:) <div id="bulletin_div" class="bulletin" style="display:none;">
isk (D) <div class="bulletin_banner">
<q;y id="closeImage” class="bulletin_op” onclick="opBulletin(’.
</aiv>

</div>
<div class="bulletin_content_out">
<div class="bulletin_content_inside">
<c:out value='${normalNotificationsulletin}' escapexml:
</div>
</div>

</div> _I

sdiv id=-"farmniu" rlace="Farm Aiuv"<

A User Login

User Name

Password

Remember Me Forget password
]
Login

Download Client

Q17: What Do | Do When the Prompt "smp_access_ip_used_by online_user is used by the user" Is Displayed?

Fault symptom: The prompt "smp_access_ip_used_by_online_user is used by the user" is displayed in the authentication
failure log on the Web page of the SMP. The address that reports the error is checked and it is found that the address is

occupied by an online user (the online duration is long).

Troubleshooting

4-14
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1. Check whether multiple DHCP servers assign the same IP address. (Ensure that the communication is normal, ping the

online user to check whether the user is actually online.)
2. After checking that the user is actually online, check the configuration on the Network Access Switch (NAS) and SMP.
NAS configuration: Check the update period on the AC:

WS6008(config)#offline-detect interval 15 threshold O This command indicates that a user is forced to go offline when

there is no traffic of the user within 15 minutes (8 hours by default).

WS6008(config)#aaa accounting update periodic 5 This command indicates that the accounting update period is 5
minutes by default.

Configuration on the Web page of the SMP: Check the user heartbeat detection interval.

If a non-SA client is used for authentication, the accounting update mechanism is adopted to keep online users alive. Enable
the accounting update function on the device of the non-Ruijie security agent client and set the accounting update period to be
consistent with the online heartbeat interval of the user.

If an SA client is used for 802.1x authentication, the heartbeat mechanism is adopted to keep online users alive. If the system
fails to receive a heartbeat notification from an online user within three consecutive online heartbeat periods, the system
considers that the user is offline and clears the user information.

VEpF. B P 4 VAL Pl IR E 0 W R SRR BRI R B D wRAE e Lt BT ¢ VALOurREE IREEE) 1 W,

Periodic Online Status Detection
Periodic Online Status Detection:
* User Online Heartbeat Period: 1200 minutes (Default: 5)

(& Tips:

The preceding figure shows an example of incorrect configuration. User Online Heartbeat Period is set to 1200 minutes,
indicating that a user is forced to go offline after the system fails to receive a heartbeat notification from the user within three
such periods (that is, 60 hours).

Q18: How Do | Rectify the Fault That a CA Certificate Error Is Prompted Before 802.1x Authentication Is Performed on

a User?

Fault Symptom

A CA certificate error as shown in the following figure is displayed when 802.1x authentication is performed on a user.

4-15



RG-Application Software FAQs V1.1

Possible Causes

Step 1. Disable 802.1x authentication. Check whether the connection is successful and whether an address can be
obtained. Ensure that the network can be connected normally.

Step 2. Use a mobile phone to perform 802.1x authentication.
Step 3. Check the system status of the SMP and check whether prompts such as CA certificate expiration are displayed.

Step 4. If no exception is found in Steps 1-2. Import the latest CA certificate for authentication.

Q19: What Do | Do When the PC Username on the Domain Controller for Authentication Is host/xxxx.xx?

Scenario Description:

A customer uses an AC to associate with the SMP and uses an AD domain controller as the authentication server. All PCs in
the customer scenario are added to the domain controller, and PC usernames used for login are already added to the domain
controller group and synchronized to the SMP server. (The domain controller group and members are already configured.)

4-16
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Customer expectation: PC users log in from the Windows PC and click Wi-Fi to connect to the wireless network. The users do
not need to enter the usernames or passwords, and the PCs automatically use the Windows credential for authentication.

Fault Description:

After most PCs served by the domain controller are connected to the wireless network associated with the domain controller,
two errors as shown in the following figures occur. (When a PC attempts to connect to the wireless network multiple times, the
user sometimes can use the username to log in successfully, for example, the username is KINGSLEY\shamundeswary.)

O host'shamundeswarykingsleylocal 2016-09-18 14:48:44 1010100253 34E6ADCF3TBT The user name cannotexceed 32 byles
0O hesvshamundeswarykingsleylocal 2016-09-18 14:46:16 10.10.100253 34E6ADCF3TBT The user name cannotexceed 32 bytes
AllNone User Name ¥ Authentication Date ~ NASIP UserIP User MAC Cause of Failure
o e y Remote Windows AD domain authenfication failed. Cause:
O hostpriya.kingsleylocal 2016-09-18 15:53:00 10.10.100.253 AA02BIEOCATD The uner name does nol eist
Locating:

See the domain controller settings.

Solution:

In the domain controller settings, Windows users are configured to use their hostnames by default instead of their usernames

to send authentication information.

In addition, run the gpupdate /force command on the CLI to update the group policy.

Q20: What Do | Do When the System Gives no Response After a User Enters the Username and Password and Clicks

Log In on the Web Management Page?

Symptom:

A user accesses the Web management page of the SMP, for example, the user enters http://172.16.3.201:8080/smp in the
address box of browser. Then, the user enters the default username and password (admin and 111111111), and clicks Login.

The system does not respond.

4-17
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{2 RG-SMP Security Management Platform - Windows Internet Explorer

@?} v | & hetp:fj172.16.3.201:3080)smp] =) [#2|1 X | Juive Search
-6 - v )

W 48 RG-SMP Security Management Platform

RG-SMP | Professional

Security Management Platform

'/' o

UserName: [admin |

Password: {..o.ooooo I

Login

Root Cause:

The compatibility mode is disabled on the browser. Perform the following operations to enable the compatibility mode (note

that some PCs support user login even if the compatibility mode is disabled).

1. The following uses Internet Explorer 10 as an example. Enable the compatibility mode and add the address of the SMP
server to the compatibility mode range.
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- >
) p-ac| o ve|R|
Print ¥
i File »
Loom (100%) >
Safety »
Add site to Apps
View downloads Ctrl+]

Manage add-ons |:
F12 Developer Tools

Go to pinned sites

Internet options

About Internet Explorer

Compatibility View Settings
m Change Compatibiity View Settings
A
Add this website:
[l Add
Websites you've added to Compatibility View:
172,16.3,.201 Remove

Display intranet sites in Compatibiity View
Use Microsoft compatibiity lists
Learn more by reading the Internet Explorer privacy statement
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Note: If the fault persists, run the netstat -ano | findstr 8080 command on the SMP server to check whether Port 8080 is

occupied.

I::\U:aers\}mr.; 't —ano i findstar G88@
'flnd"'l'n'l:‘ 1 as an internal or external command.,

i findstr 8838
:Hl:l EI H.A.H.8:4 I..-l‘thlHL
8Bgn 192.168.113.164:498Y4
-BBgn 192 .168. 164:498%75
:BUEn 192.168. 16449876
:BHEe 192.168. 16449877
:BBgn 192.168. 164:498%78
:BUgy 192.168. 16449877
:BUgy 192.168.113 16442888
28888 B.0.8.@:

174,
172,
172.
172,
174,
172.
172.
172.

Q21: How Do | Do When the SMP Server Needs to Be Modified to Support the Chinese Coding Mode?

Log in to Windows 2008, choose Control Panel > Clock, Language, and Region > Change Display Language and perform

operations as shown in the following figure.
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m — ¥ All Control Panel Ttems
¢ Region and Language i 5]

Fomats | Location | Keyboards and Languages  Administrative |

-~ Welcome screen and new user accounts

View and copy your international settings to the welcome screen, system
accounts and new user accounts,

yistrative Tools

| % Copy settings... I
Tell me more about these accounts Management

" Language for non-Unicode programs

This setting (system locale) controls the language used when displaying i

text in programs that do not support Unicode. o

Current language for non-Unicode programs: L

English (United States)
% Change system locale...
is ocale?
hard
tation Area Icons
ams and Features
ok | cancel | sl |
snanrd UL, S LY TS0 Sound
4.2 SNC

Q1: How to log in to the MySQL database?

On the SNC server, open the command prompt and enter the default installation directory C:\Program Files\MySQL\MySQL
Server 5.1\bin (change the directory based on practical conditions), and run mysgl -uroot -padmin -P3307. Log in to the MySQL

using the user name root, password admin, and port No.3307, as shown in the figure below:
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A8 - mysql —uroet —p

ft Windows [H 5.2.37981
PR 1985-20883 Microsoft Corp.

C:\Documents and Settings\dministratordcd C:\Program Files\MySQL\MySQL Server 5
.5\bin

C:\Program Files\MySQL\MySQL Server 5.5\bin>mysql —uroot -padmin -P3387
Welcome to the MySQL monitor Commands end with ; or \g.
Your MySQL connection id is 387
sion: 5.5.19 MySQL Community Server (GPLD
Copyright <(c)> 20080, 2011, Oracle and/or its affiliates. All r»rights reserved.
a registered trademark of Oracle Corporation and/or its
. Other names may bhe trademarks of their respective

Type 'help;’ or \h’ for help. Type ’\c¢’ to clear the current input statement.

nysql>

Q2: How can | restore the password for the SNC admin if | forgot it?

On the SNC server, open the command prompt locally, and enter the directory C:\Program Files\MySQL\MySQL Server 5.1\bin.

Run mysql -uroot -padmin -P3307 to log in to the MySQL, and run the following two commands:

Use emp;

update t security app user set password =~ 21232f297a57a5a743894a0e4a801fc3’ where id = 1;

If a message Query OK is displayed, the password has been restored to the default one, namely admin. If the information

marked in red boxes in the following figure is displayed, the configuration is successful.

on 6.0.6801]
asoft Corporation All rights re edl .

Adninistratoricd C:\P . Fi Le s My SMySQL Server 5.1%bin
Aaysgl —uroot =-padmin =P 3387
d wrtivorgT
r MySQL

yer e

to clear the buffer.

urity_app_use T o 2172 2 Vat Y4abedaBilf

ey U H rows allbected (M.HH
matched: 1 Changed: @ War

mysql> _

Q3: How to backup and restore the MySQL database of SNC?

The SNC database is saved in the database folder under the SNC installation directory, but not in the MySQL installation
directory.
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Disable the SNC Service first, backup the entire database folder under the SNC installation directory, and replace the original

database folder for restoration.

Note: Ensure that the versions of the SNCs are the same. For example, the database saved on
SNC_2.30(p2) _EN_Build2015121 can be restored only to RG-SNC_2.30(p2)_EN_Build20151211.

Q4: The SNC serviceis started normally and the login page is displayed normally, but the system freezes up when the
user name and password are entered.

If the SMP micro dongle is used, the SNC service can also be started, but the license displayed is incorrect. The SNC Web
management page can be displayed, but the system freezes up when the user name and password are entered.

Q5: The SNC server cannot be started and is stuck on the Web Service Starting screen.

Step 1: Check whether the firewall is disabled.

Step 2: Check whether multiple network interface cards are used and disable the unwanted ones.

Step 3: Check whether MySQL services in the system is enabled; if not, enable the services manually.

Step 4: Check whether the MySQL Port 3307 of the database is occupied.

Step 5: Check whether ports snmp(udp161), tftp(udp69), syslog(udp514), and tcp8088 are occupied.

Step 6: Check whether the configurations of the hardware meets requirements, for example, whether the memory is too small.
Step 7: Choose Web Service > Log Collect to collect the logs and report it to Ruijie post-sales department.

r

Database Service @ Running Web Service

L¥Restart WStop El Log Collect | £Restart BStop Bl Log Collect

Q6: The Device type is displayed as Unknown and no panel figure is displayed.

The fault may be caused by the following issues:

Step 1. The Simple Network Management Protocol (SNMP) and Telnet templates are configured incorrectly.
Check whether the SNMP and Telnet templates are correct.

Step 2. The SNC is unreachable for the device.

Check whether the SNC server and the device can be pinged.
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Step 3. The device model is not supported by SNC and a customization is required.

a) Choose Device > Select a device > Basic Info, and obtain the SysOID.

Basic Info CPU Memory Temperature Alarm

VSU-557 P 172.29.2.254

Switch Model £5750-24gt/8sfp-e

Ruijie Networks Sys0ID 1.3.6.1.4.1.4881.1.1.10.1.111
255.255.255.0 MAC Address 14:14:4b:7d:00:7b

Device Location

14 days, 18:28:30.37 Last Synchronization Time 2016-01-01 16:35:49 T¥sSync

b)  Provide the device model and panel figure.

¢) Report the information to Ruijie, and we will customize the panel based on practical conditions.

Q7: Does the SNC support the device of 3rd Party manufacturers?

The SNC manages a device using the SNMP and Telnet. The devices from other manufacturers should support the SNMP and
Telnet. The SNC supports the standard request for comments (RFC) management information database (MIB). However, the
SNMP may vary with different manufacturers, and the MIB may not fully conform to standards (some manufacturers may realize
the functions supported by a standard MIB in a private MIB). Therefore, the functions vary with different devices.

Q8: What is the update interval for the different modules on SNC?

Step 1: For the devices that are added to the monitored device list and are displayed in Top N utilization on the SNC Home

Page, the update interval is 5 minutes and such interval cannot be changed.

Step 2: For the devices that are added to the real-time monitored device list, the update intervals of the monitoring indicators
can be changed, and it impacts the intervals of the single device view and all view. It does not impact the Top N utilization on
the SNC Home Page.

Step 3: For Topology, The update interval 1 min and cannot be changed. If an alarm, for example, a link down alarm, is
generated in the update interval, the SNC will not upgrade the status of the topology link immediately unless you click the
synchronization button manually. The SNC will perform the updated status after 1 min interval.

Q9: There is no responding when telnet device via SNC.

Step 1: This fault is caused when the safety strategy of the Internet Explorer (IE) forbids the direct calling of Telnet in the IE. In
this case, you can change the registration table by copying the following content to the notebook, save it as a .rag file, and

double click it to run the file.
REGEDIT4

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet
Explorer\Main\FeatureContro\FEATURE_DISABLE_TELNET_PROTOCOL]
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"iexplore.exe"=dword:00000000.
If the fault persists, proceed to Step 2.

Step 2: Install SecureCRT on the PC, and choose Options > Global Options > Web browser to set SecureCRT as the default
Telnet program, and try to telnet again.

Q10: Can the SNC monitor and manage the server or PC client?

The SNC can discover and display a terminal device in a topology, but can only display the basic information.

You need to enable the SNMP service on the server or PC, and configure the corresponding community string.

Service Faults

The Device Is Unreachable over SNMP and the Device Information Cannot Be Obtained

1. The SNC and device cannot ping each other.
Countermeasure: The network malfunctions. Ask the customer to help rectify the fault.

2. SNMP Port 161 is blocked by the firewall. Use the MIB tool to check whether the port is actually blocked by the firewall.
Countermeasure: The fault is caused by environment settings. Ask the customer to help rectify the fault.

3. No SNMP community string is configured for the device.

Countermeasure: Run the following command on the device (the command uses the community string public as an

example): snmp-server community public rw
4. The SNMP community string configured on the device is inconsistent with the SNMP template on the SNC.

Countermeasure: Set the SNMP community string on the device so that it is consistent with the SNMP template on the
SNC.

When SNMP Connection Is Reachable, the Device Model Cannot Be Identified and Unknown Is Displayed

1. The device model is not embedded. Choose Device > Device Model to check whether the model can be found.
Countermeasure: Choose Device > Device Model and add this model. You can check the sysoid on the device details
page.

2. When the device is added, an incomplete MIB is obtained.
Countermeasure: Access the device details page and click Synchronize.

3. The device MIB is not implemented correctly. Access the device details page and check whether sysoid is set to a value..

Countermeasure: Reach out to us on Skype (Skype account :service_rj@ruijienetworks.com) at any time for assistance.
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The CLI Shows That the Device CPU Usage, Memory Usage, and Temperature Are Low but a Threshold Exceeding
Alarm Is Generated on the SNC

For all faults that information on the SNC is inconsistent with that on the CLI, rectify the faults as follows and use the MIB tool

to obtain the oid value:

1.

The value returned by the MIB tool is always high. Use the MIB tool to obtain the oid values of the CPU, memory, and
temperature for verification.

CPUOID: .1.3.6.1.4.1.4881.1.1.10.2.36.1.1
Memory OID: .1.3.6.1.4.1.4881.1.1.10.2.35.1.1.1

Temperature OID in sequence: 1.3.6.1.4.1.4881.1.1.10.2.1.1.16.0  /1.3.6.1.4.1.4881.1.1.10.2.1.1.44.1.5/
1.3.6.1.4.1.4881.1.1.10.2.1.1.23.1.3

Countermeasure: Reach out to us on Skype (Skype account :service_rj@ruijienetworks.com) at any time for assistance.

The CPU usage, memory usage, and temperature soar instantaneously but the values returned by the MIB tool are within
the normal range. Start packet capture on the SNC server to capture SNMP packets. Determine the observation period
based on the fault occurrence frequency and analyze the SNMP packets that are captured in the observation period to
check whether the CPU usage, memory usage, and temperature soar instantaneously.

Countermeasure: None. It reflects the real status of the device. If the alarm can be ignored, you can cancel performance
monitoring of the device.

The Device Is Reachable but an Unavailability Alarm Is Reported on the SNC

1.

It is true indeed that the device is unreachable at some time. Capture ICMP packets on the SNC server for verification and
determine the observation period based on the alarm occurrence frequency.

Countermeasure: Ask the customer to locate and rectify the network fault. If the alarm can be ignored, you can enable

the device not to generate the unavailability alarm in the alarm event.

Failure to Backup Configuration

1.

The telnet template is configured incorrectly.
Countermeasure: Change the telnet template parameters to be consistent with actual parameters.

The network does not work properly. Run the following command on the device for verification: copy flash:config.text
tftp://ISNC-IP/a.text.

Countermeasure: Ask the customer to rectify the network fault.
The device model is unknown.

Countermeasure: Connect the device to the SNC over SNMP successfully. If the device cannot be identified yet, manually

add the device model.
The device name contains special characters such as #.

Countermeasure: Remove special characters such as #.

4-26



RG-Application Software FAQs V1.1

The Topology Is Incomplete
1. Key devices (core device or convergence device) are not included for management.

Countermeasure: Configure an SNMP community string for the key devices, and enable device auto-discovery so that

the key devices could be managed.
2. The Complete L2 switch info. Option is not selected.

Countermeasure: Telnet to many devices to ensure that the devices (all managed devices) are reachable, enable topology

discovery, and select the Complete L2 switch info. Option.

Complete L2 switch info. [E

No Syslog Are Generated
1. Thereis no relevant log server configuration on the device.
Countermeasure: Make relevant configuration.
2. Capture syslog packets on the SNC to check whether syslog packets are filtered out by the firewall.

Countermeasure: Modify the firewall policy.

System Faults

A Prompt, Indicating That Hardware Information Verification Fails, Is Displayed When a License File Is Imported, or a
Prompt, Indicating That the Hardware Code Is Inconsistent with the Current Device, Is Displayed When the Web

Service Fails to Be Started
1. The device whose hardware information is collected, is not the machine, into which the license file is imported.

Countermeasure: Use the current server to re-collect hardware information and go through the file license application

process.
2. The license file of another server is imported.
Countermeasure: Import the license file of the current server.

3. The version of the device whose hardware information is collected, is incompatible with the version of the device, into
which the license file is imported. For example, the version of the device whose hardware information is collected is vmotion

whereas the version of the device, into which the license file is imported, is a universal version.

Countermeasure: If the version of the device whose hardware information is collected is not an expected version, install
the expected version and re-collect hardware information. Therefore, go through the SNC server change process. If the
version of the device whose hardware information is collected is an expected version, uninstall the current version, install

the correct version, and import the license file.

4. The hardware information is changed during hardware information collection and license file importing.
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Countermeasure: For a common version, this fault occurs when the main board, hard disk, or NIC is changed. In this case,

reapply a license in the scene of host change and re-collect hardware information.

For the vmotion version, this fault occurs when the OS is re-installed (regardless of whether the OS of the physical machine or

virtual machine is installed). In this case, reapply a license in the scene of host change and re-collect hardware information.

The Web Service Fails to Be Started

1.

The memory is insufficient.
Countermeasure: Increase the memory to ensure that the minimum memory is 4 GB.

In case port conflict occurs, enable all ports, including the Web service port 8088 /TFTP port 69 /trap port 162 /syslog port
514/tomcat port 8080. Move the cursor over the Web service. A conflict prompt should be displayed. If no prompt is
displayed, use the port viewer tool to locate and rectify the fault. For example, if Port 8080 conflicts, there is a high
possibility that two java.exe files are found in the process.

Countermeasure: Uninstall the software that causes the conflict, change the port ID for the software, and disable relevant

services.

This fault occurs in an upgrade scenario. The database of an earlier version is used for replacement or restoration after

an upgrade.

Countermeasure: Data of the earlier version is inherited after the upgrade and no manual intervention is required. Use the
database that is not manually intervened after the upgrade.

A version is newly installed and the database of an earlier version is used for replacement or restoration.
Countermeasure: Use the database of the version that is newly installed, to complete configuration and deployment.
The imported file license is lost, for example, there is wlan-license-100 but the WLAN license component is lost.

Countermeasure: The required licenses are not completely purchased or the license may be lost. Retrieve the complete
license file and then import it.

The Web Service Automatically Stops for No Reason during System Running

1.

Virtual machine migration occurs but a common version is installed, and the file license fails.
Countermeasure: Install the vmotion version, go through the host change process, and re-apply for the license file.
The test license expires.

Countermeasure: Contact local after-sales engineers to renew the license or purchase the formal license.

The MySQL Service Fails to Be Started and Error 1067 Is Reported When the Service Is Manually Started

1.

The database is damaged because of an abrupt power failure of the server or other causes.

Countermeasure: Perform the following steps to restore device information. Other data needs to be re-configured. Before

performing these operations, negotiate with the customer first.
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A. Stop the MySQL-SNC service. Access the SNC installation directory and open the \mysgl\my.ini file, add
innodb_force_recovery=6 (if the database cannot be opened, set it to 1-5 in sequence for testing) to the end of the file. Then,
start the MySQL-SNC service.

B. Install navicat and run the following command to configure a database connection: localhost 3307 root admin.

C. Right-click the et_telnet_tmpl and et_snmp_tmpl tables and choose Dump SQL File from the shortcut menu to back up
the et_telnet_tmpl and et_snmp_tmpl tables.

D. Open the et_device table, open the asset import template, and enter IP addresses in the Device IP column in the template,
and enter the SNMP template name and Telnet template name (can be found in et_telnet_tmpl and et_snmp_tmpl)

corresponding to snmptmpl_id and telnettmpl_id in the snmp\telnet template in the asset template.

E. Uninstall and then re-install the SNC. Start navicat, restore the et_telnet_tmpl and et_snmp_tmpl tables, and then import
the edited asset template.

A Lot of Accessed Web Pages Are Abnormal, the Web Service Is Abnormal, or the Web Service Is Always Starting

1.

The disk where the SNC installation directory is located is fully occupied.
Countermeasure: Expand the disk, clear unnecessary files, or re-install the SNC to a disk with sufficient space.

The MySQL service is abnormal. Access the OS management tool and check whether a large number of errors are
generated for the MySQL service in the event manager.

Countermeasure: Refer to the case that error 1067 is reported when the MySQL service is started.

When a License File Generated by the Dongle Is Imported After a Host Change, a Prompt Is Displayed, Indicating That

No Dongle Is Inserted and the License File Cannot Be Imported

1.

The license process is not performed in this scenario.

Countermeasure: Copy the license file to the SNC installation directory \snc\WEB-INF\classes\ and then start the Web

service.

4.3SAM

Q1: What Are Precautions When 802.1x Authentication Is Conducted Using the SAM+ System and Wireless Device?

When the authentication client that comes with Windows is used for 802.1x authentication, Access Control must be set to Smart

Device Access in the SAM+ system. Otherwise, authentication fails.

Q2: What Are the Steps of Setting the Authorization QR Code?
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Step 1: Create a Guest Guarantor

Choose System > Guest Mode from the main menu to access the Guest Authentication Setup page. Click Add Guest Guarantor
Ranking to create a Guarantor.

+ . v 1
SAM SECURITY ACCOUNTING MANAGEMENT SYSTEM A& admin | 2 About | O Logout

Shortcut Channel &+ Homepage System Security User Access Control Billing Account Operation

Location: System > Guest Mode

‘Guest Authentication Setup

Guest Account Creation by SMS Authorization Code Mode: grapied
Public Mode: Disabled Enable
Guest QR Code Feature Enabled QR Code Management

Add Guest Guarantor Ranking

Ranking Name No. of Guests Max Duration Check  Modify Delete

test! 12 2Hrs 172.29.2.2:8080/sam = Ey X
Qri 1 1Hrs WWW.BAIDUCOM B E3 X
Qr2 1 1000Hrs www.baidu.com B Ey ¥
QR3 1 1Hrs www.baidu.com = EY X
QR4 1 1000Hrs www.baidu.com B Ey ®

+
SA M SECURITY ACCOUNTING MANAGEMENT SYSTEM

Shortcut Channel 5 Homepage System Security User Access Control

Location: System > Guest Mode > Guarantor Authorization Level Management > Add

Guest Guarantor Ranking

Ranking Name* | Example |

Max Guest Number* 10 Users
Max Duration* | 100 |Hrs
Homepage* | wmw.ruijienetworks.cn|

Allow to change

[] Allow
homepage

Guest's User Group* test ==

Free User Template

Free Plan

Save Cancel

Step 2: Set the self-service privilege

Choose Security > Self-service Privilege from the main menu to access the Self-service Privilege page. Click Add to add a user

self-service permission.
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+ - ) 1
SAM SECURITY ACCOUNTING MANAGEMENT SYSTEM A admin | B about | O Logout

Shortcut Channel Homepage System Security User Access Control Billing Account Operation

Location: Security > Self-service Privilege

patoriyName | | 2 Gerers e

Delete the Selected

Total of 3 records, the currently displayed 1 to 3 records &@ Currently DPage #Go Very Page Entry
W Authority Name Creator Self Pause Interval (days) | Description Modify Check
Al Self-service Pr
admin 30 Own all self-service privileges, including troubleshooting, recharging, etc. E‘ =
ivileges
[ R admin 30 By B

Select Guest QR-code Application in Available Functions.

i . - -
SAM SECURITY ACCOUNTING MANAGEMENT SYSTEM & admin | B About | O Logout

Shortcut Channel {3 Homepage System Security User Access Control Billing Account Operation

Locatiom: Security > Self-service Privilege > Add

User Self Permissions

Authority Name® Self Pause Interval (days) ]
rity Name (0~9999 days) 0 rep! limited.

Expand All[Collapse All

[Cselect Al
= [¥] Guest
- []SMS Authentication Code Application
;
-~ [] Cancel Auto Login
&~ [] Terminal Management
- [JUnbind Real-name Terminal
~~[] Network Access Description
~~[]Bill Details
-~[] My Package
~~[]Self-suspension
-] Self-recovery
[ Network Information
[ Personal Information
-~[]Change Package

Available Functions

Step 3: Create a user

Choose User > User Management from the main menu to access the User Management page. Click Create Account to add a
user.
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-+ .
SAM SECURITY ACCOUNTING MANAGEMENT SYSTEM A admin | B About | O Logout

Shortcut Channel Homepage Access Control Billing Account Operation

Location: User » User Management

Import Search Username ‘ ‘ @ Multiple Usernames
Account ‘ ‘
Balance ‘ | - ‘ ‘
Batch Account Activation User Templates ‘ Please Select v‘
Import Accounts Plan ‘ Please Select v ‘
Billing Policy [Please Select v| User |P(v4) Range ‘
Import Changes
P 9 User Group l:lmﬁ []Contains The Child User Groups Account Creation Time ‘
Import Payments Account Creation Source ‘ Please Select V‘ Account Pre-Cancellation Time ‘
Import Change User Templates and Recent Offline Duration - Inactive Network Users Within This User Status.
Plans [] Recently od
Import Change User Group [J from I:l 3 inactive Network Users From
Pause Duration ‘ | B ‘ | B8
Last Self-service Pause Duration ‘ | B ‘ | B

In Basic Information, select the created self-service permission and guarantor ranking.

+ .
SAM SECURITY ACCOUNTING MANAGEMENT SYSTEM Sadmin | B about | O Logout

Shorteut Channel & Homepage  System  Security [MIETMN Access Control  Billing  Account  Operation

Location: User > User Management

User Search Basic Information
Import Search Username* |Example ‘ Full Name ‘ ‘
Confirm
Password* [ovaece | [eccnee |
User Group* | ‘ = Account Same As username £33
Batch Account Activation
User Templates @ Use Defautt Template of User Group () Customize
Import Accounts Self-service ion-
|Example v‘ ‘Veriﬁcaﬁun is required v‘
Permissi free
Import Changes Pre-
| ‘ = BACL ‘ Please Select v| &
Import Payments Cancellation
Guarantor Ranking | Example v‘ I
Import Change User Templates and
Plans Advanced Options ] Show Advanced User Settings options
Sex | Please Select V‘ Email Address ‘ ‘
Import Change User Group
ID Type [Prease Setect vl IDNe.
Online
Education Level | Please Select v‘ ‘ ‘
Information
Telephone No. | ‘ Mobile Phone ‘ ‘
Address | ‘ Postal Code ‘ ‘

Step 4: Generate an authorization QR code

Enter the self-service platform address http://xxx.xx.xx.xx:xxxx/selfservice/ in the address box of the browser, and then enter

the created username and password for login.
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e }Ce http://222.76.49.13:1112/selfservice/ P~ i‘ @& Campus Self-service Net... %

~) CAMPUS SELF-SERVICE PORTAL

CAMPUS SELF-SERVICE PORT Login

B Remember Password

Use Credit

Easy to (Top—up Account Inquriy
AL ; Login in

Click Guest on the user home page.

ai* i?"\@ http://222.76.49.13:1112/selfservice/ P~ H @ Campus Self-service Net... % ‘@ SAM+ Security Accounting .. ‘ ‘

CAMPUS SELF-SERVICE NETWORK

Example , Good Afternoon o not

overindulge in the Internet.

6

My Device Guest

All rights reserved.©2000-2015 Ruijie Networks

Click Generate in the displayed Guest Authentication Management dialog box.
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a@\é hitp://222.76.49.13:1112/selfservice/ D - © [ @ Campus Seff-senvice Net.. * | & SaM+ Securly Accounting . | |

Guest Authentication Management

Invitation Code

Generates four numbers or letters. Guest login page, enter

the invitation code applies to the Intemet using computers

and mobile phones to guests. Generate

QR Code

Generate a QR code, guests can try scanning app to scan the
Intemet to obtain the pemmission for the use of mobile
phones to guests.

Set authorization QR code parameters and then click Submit.

e@\e ttp://222.7649.13:1112/selfservice/ £+ 0@ campus s service Net.. x| SAM+ Security Accouting . | |

Activate Invitation Code and QR Code

Effective Ti mer 6-06-23 15:28:35

Ineffective

Fm 6-06-30 15:28:38
Time

Max Network
Access 1 Hrs (1-100)
Duration

User Number Users(1-10)

Creation Cause v

Landing Page
After Login

www.ruijienetworks.com

Submit

The QR code is generated successfully, as shown in the following figure.
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e @ | € http1222.76.49.13:1112/selfservice/

£ - ¢ |[@ campus self-service Net. xlﬂsnmmmymﬂﬁg_ ‘ ‘

Activate Invitation Code and QR Code

Effective Time of Invitation Code and QR Code :

2016-06-23 15:28:35 To 2016-06-30 15:28:38

User Number of Invitation Code and QR Code : 1 Users Q

Invitation Code QR Code

DXVT
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